Kubios HRV Analysis
version 2.0 beta

USER’S GUIDE

June 13, 2006

Mika P. Tarvainen, Ph.D.
(Mika.Tarvainen@uku.fi)
and
Juha-Pekka Niskanen

Biosignal Analysis and Medical Imaging Group (BSAMIG)
(http://bsamig.uku.fi/)
Department of Physics
University of Kuopio
Kuopio, FINLAND
Contents

1 Overview .......................... 4
  1.1 System requirements ................. 5
  1.2 Installation .......................... 5
  1.3 Uninstalling the Kubios HRV Analysis ........................................ 13
    1.3.1 Automated uninstall ................. 13
    1.3.2 Manual uninstall .................... 13
  1.4 Software home page .................. 14
  1.5 Structure of this guide ............... 14

2 Heart rate variability .................. 16
  2.1 Heart beat period and QRS detection ................. 17
  2.2 Derivation of HRV time series .................. 18
  2.3 Preprocessing of HRV time series .................. 19
    2.3.1 Smoothness priors based detrending approach .............. 20

3 Analysis methods ..................... 22
  3.1 Time-domain methods .................. 22
  3.2 Frequency-domain methods ............... 23
  3.3 Nonlinear methods ..................... 23
    3.3.1 Poincaré plot ....................... 24
    3.3.2 Approximate entropy ................. 25
    3.3.3 Sample entropy ....................... 25
    3.3.4 Detrended fluctuation analysis .............. 26
    3.3.5 Correlation dimension .................. 27
    3.3.6 Recurrence plot analysis ............... 28
  3.4 Time-varying methods .................. 30
  3.5 Summary of HRV parameters ............... 30

4 Software description ................... 32
  4.1 Input data formats ..................... 32
  4.2 The user interface ..................... 34
    4.2.1 RR interval series options .............. 34
    4.2.2 Data browser ......................... 35
    4.2.3 Analysis options ....................... 37
    4.2.4 Results view ......................... 37
    4.2.5 Menus and toolbar buttons ............... 41
  4.3 Saving the results ..................... 42
    4.3.1 ASCII-file ......................... 42
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.2 Report sheet</td>
<td>43</td>
</tr>
<tr>
<td>4.3.3 MATLAB® MAT-file</td>
<td>46</td>
</tr>
<tr>
<td>4.4 Setting up the preferences</td>
<td>47</td>
</tr>
<tr>
<td>5 Sample runs</td>
<td></td>
</tr>
<tr>
<td>5.1 Sample run 1: General analysis</td>
<td>51</td>
</tr>
<tr>
<td>5.2 Sample run 2: Time-varying analysis</td>
<td>56</td>
</tr>
<tr>
<td>A Frequently asked questions</td>
<td>59</td>
</tr>
<tr>
<td>B Troubleshooting</td>
<td>62</td>
</tr>
<tr>
<td>References</td>
<td>63</td>
</tr>
</tbody>
</table>
Chapter 1

Overview

The Kubios heart rate variability (HRV) analysis software\(^1\) is developed by the Biosignal Analysis and Medical Imaging Group at the Department of Physics, University of Kuopio, Kuopio, Finland. The software is a considerable extension to the previous version (version 1.1) of the software described in [32]. The software has been programmed using MATLAB\(^\text{®}\) 7.0.4 Release 14 Service Pack 2 (The MathWorks, Inc.) and was compiled to a deployable standalone application with the MATLAB\(^\text{®}\) Compiler 4.2. The MATLAB\(^\text{®}\) Component Runtime (MCR) is required for running Kubios HRV Analysis.

Kubios HRV analysis is an advanced tool for studying the variability of heart beat intervals. Due to its wide variety of different analysis options and the easy to use interface, the software is suitable for researchers and clinicians with varying premises. The software is mainly designed for the analysis of normal human HRV, but should also be usable, e.g., for animal researchers.

The developed software includes all the commonly used time- and frequency-domain variables of HRV. The frequency-domain variables being calculated for both nonparametric (Fourier transform based) and parametric (autoregressive modeling based) spectrum estimates. In addition, the software calculates several nonlinear variables such as the Poincaré plot, recurrence plot analysis, detrended fluctuation analysis, approximate and sample entropies, and correlation dimension. Furthermore, the software also includes time-varying analysis options. For example, the time-varying changes in all the time- and frequency-domain variables are supported. The variation of the frequency-domain variables is obtained through time-varying spectrum estimation for which the commonly used spectrogram and the statistically sophisticated Kalman smoother methods are available.

In addition to the usability of the program user interface, attention has also been paid in the presentation and saving of the analysis results. On the one hand, the software generates two report sheets which include all the analysis results in a compact form. These report sheets can be either printed or exported to various file formats including portable document format (PDF). On the other hand, the results can also be saved in an ASCII text file from which they can be imported to a spreadsheet program such as Microsoft Excel\(^\text{®}\) for further inspection.

---

\(^1\)Kuopio University has only limited rights to the software. These limited rights are governed by a certain license agreement between Kuopio University and The MathWorks, Inc.
1.1 System requirements

The system requirements given below should be considered as recommended system requirements. The software may work also with lower system specifications, but will probably function slower or with reduced usability.

- Microsoft® Windows XP/2000 operating system
- 1 GHz or higher Intel® compatible 32-bit (x86) processor
- 256 MB of RAM (512 MB or higher recommended)
- Desktop resolution of 1024×768 or higher
- The MATLAB® Component Runtime (version 7.2)
- The Kubios HRV Analysis will require about 10 MB and the MATLAB® Component Runtime about 230 MB of hard-disk space.

1.2 Installation

Kubios HRV Analysis was developed using MATLAB® 7.0.4 (R14SP2) and compiled to a deployable standalone Windows application with the MATLAB® Compiler 4.2. Therefore, the MATLAB® Component Runtime (MCR) needs to be installed for Kubios HRV Analysis.

1. Make sure that you have administrator rights and run the Kubios HRV Analysis installer file. This will launch the setup wizard. To proceed with the installation click the Next button, or click the Cancel button to exit installation.
1.2. Installation

2. The next setup window displays the License Agreement for the software. Read the License Agreement carefully before proceeding. If you accept all the terms and conditions of the Agreement you are allowed to continue the installation. IF YOU DO NOT AGREE WITH ALL OF THE TERMS AND CONDITIONS OF THE LICENSE AGREEMENT, YOU CANNOT CONTINUE THE INSTALLATION.

3. Next, select the destination folder in which the software should be installed. To select the default destination C:\Program Files\Kubios HRV Analysis click the Next button. If you want to select a different folder click the Browse button. If the selected folder exists, setup will ask if you a confirmation before installing in this folder.
4. Next, select the components you want to install (only the checked components will be installed). The Kubios HRV Analysis will always be installed, but you may choose not to install the MATLAB® Component Runtime by unchecking the box next to it. NOTE: MATLAB® Component Runtime is required to run Kubios HRV Analysis so uncheck it only if you have MATLAB® Component Runtime (version 7.2) already installed.

5. Then select the Start Menu folder in which the program’s shortcuts are created. The default Start Menu folder is Kubios HRV Analysis. You can select a different Start Menu folder by clicking Browse. You can also choose not to create a Start Menu entry.
1.2. Installation

6. In the next setup window you can select if the installer creates Desktop and/or Quick Launch icons for software. Select the desired additional icons and click Next to continue.

![Setup - Kubios HRV Analysis](image1)

7. The setup is now completed and the installer is ready to install the Kubios HRV Analysis and MATLAB® Component Runtime (if selected) on your computer. Check the selected installation options summarized in the setup window and click the Install button to start the installation. If you want to change any of the installation settings click the Back button.

![Setup - Kubios HRV Analysis](image2)
8. Wait while the installer copies the necessary files on your system. This can take a few minutes.

9. After the installer has finished copying the necessary files, the MATLAB® Component Runtime installer starts. Choose Next to continue the installation. NOTE: If you have selected not to install the MATLAB® Component Runtime earlier in the Select Components page, you can skip to section 15.
1.2. Installation

10. The MATLAB® Component Runtime setup wizard starts. Choose Next to continue.

11. Next, select the destination folder in which the MATLAB® Component Runtime should be installed. To select the default destination (C:\Program Files\MathWorks\MATLAB Component Runtime) click the Next button. If you want to select a different folder click the Browse button. You can view available and required disk space on your system by clicking Disk Cost. You can also choose whether you want to install the MATLAB® Component Runtime for just yourself or others. Finally, choose Next to continue.
12. Confirm your selections by choosing Next.

13. The installation begins. The process takes some time due to the quantity of files that are installed.
14. When the installation completes, click Close to close the MATLAB® Component Run-
time installer.

![MATLAB Component Runtime](image)

15. Finally, to exit the setup wizard click the Finish button.

![Setup - Kubios HRV Analysis](image)

Now, all the components required for the Kubios HRV Analysis software are installed. You can launch the Kubios HRV Analysis by selecting it from the created Start Menu folder or by clicking the Desktop icon (if created). Please note that the starting of Kubios HRV
Analysis also starts the MATLAB® Component Runtime and may take some time especially with older computers.

1.3 Uninstalling the Kubios HRV Analysis

The Kubios HRV Analysis can be uninstalled either automatically using the uninstaller or manually if the uninstaller fails for some reason. Both methods for uninstallation are described in the following.

1.3.1 Automated uninstall

The preferred and the most straightforward way of uninstalling the Kubios HRV Analysis is to use the automated uninstaller. The uninstaller can be launched by selecting “Uninstall Kubios HRV Analysis” from the software’s Start menu folder (the default Start menu folder is Kubios HRV Analysis). The software can also be uninstalled from the “Add or Remove Programs” under the Windows Control Panel. These are the two recommended ways of uninstalling the Kubios HRV Analysis and either one of them should always be used for uninstallation. If, however, for some reason the uninstaller fails, a manual uninstallation may be necessary. Additionally, note that the Kubios HRV Analysis uninstaller does not uninstall the MATLAB® Component Runtime. Furthermore, the uninstaller does not remove your preferences settings. These have to be deleted manually from C:\Users\<username>\Application Data\HRV2.

If you want to remove the Kubios HRV Analysis permanently from your computer, you should also uninstall the MATLAB® Component Runtime. The MATLAB® Component Runtime can be uninstalled from the “Add or Remove Programs” under the Windows Control Panel. Note, however, that if you are uninstalling Kubios HRV Analysis just to update it with a newer version, you do not necessarily need to uninstall the MCR (detailed instructions of such situations will be given at the Kubios HRV Analysis web site).

1.3.2 Manual uninstall

Kubios HRV Analysis

The manual uninstallation should be conducted only if the automated uninstallation fails. The Kubios HRV Analysis can be completely uninstalled manually by deleting the following files, folders, and registry entries:

- Delete the install folder (by default C:\Program Files\Kubios HRV Analysis) and all the subfolders and files in it
- Delete the HRV2 folder (if exists) from C:\Users\<username>\Application Data\ (NOTE: The Application Data folder is a hidden folder and you may need to enable the “Show hidden folders” option in the “Folder Options” found under “Control Panel”).
- Delete the Kubios HRV Analysis quick launch icons (if exist) from C:\Users\<username>\Application Data\Microsoft\Internet Explorer\Quick Launch\ and desktop icons (if exist) from C:\Users\All Users\Desktop\
1.4. Software home page

- Delete the possible Start menu entries from
  C:\Documents and Settings\All Users\Start Menu\Programs\

- Remove the Kubios registry entry from
  HKEY_LOCAL_MACHINE\SOFTWARE\Kubios\HRV

PLEASE NOTE THAT MODIFYING THE WINDOWS REGISTRY CAN CAUSE SERIOUS PROBLEMS THAT MAY REQUIRE YOU TO REINSTALL YOUR OPERATING SYSTEM. USE THE INFORMATION PROVIDED AT YOUR OWN RISK.

- Manual removal of the Kubios HRV Analysis entry from the Windows’ “Add or Remove Programs” list requires modifying registry. A thorough instructions on how to manually remove programs from the “Add or Remove Programs” list is available on the Microsoft support web site at http://support.microsoft.com/?kbid=314481.

MATLAB® Component Runtime

The MATLAB® Component Runtime can be completely uninstalled manually by deleting the following files, folders, and registry and system path entries:

- Delete the install folder (by default C:\Program Files\Mathworks\MATLAB Component Runtime) and all the subfolders and files in it

- Remove the MATLAB® Component Runtime entry (<MCR install dir>v72\runtime\win32) from the system path

- Manual removal of the MATLAB® Component Runtime entry from the Windows’ “Add or Remove Programs” list requires modifying registry. A thorough instructions on how to manually remove programs from the “Add or Remove Programs” list is available on the Microsoft support web site at http://support.microsoft.com/?kbid=314481. PLEASE NOTE THAT MODIFYING THE WINDOWS REGISTRY CAN CAUSE SERIOUS PROBLEMS THAT MAY REQUIRE YOU TO REINSTALL YOUR OPERATING SYSTEM. USE THE INFORMATION PROVIDED AT YOUR OWN RISK.

1.4 Software home page

The Kubios HRV Analysis (version 2.0 beta) home page on the web can be found at

http://kubios.uku.fi/

where you can find current information on the software and download possible updates and related material.

1.5 Structure of this guide

The aim of this guidebook is to help the user to get started with the Kubios HRV analysis. It should not, however, be thought of as being an easy to follow step by step manual, but more like a reference material from which you can probably find answers to your problems related to HRV analysis or usability of the software. The structure of this guide is as follows.
1.5. Structure of this guide

After the overview chapter, from where you will find useful information about the system requirements and installation, an introduction to heart rate variability is given in Chapter 2. This chapter starts with a short discussion on the control systems of heart rate after which the extraction of heart beat periods is discussed and the derivation of HRV time series is described. The rest of the chapter is focused on the preprocessing of HRV data and gives a detailed description of the smoothness priors based detrending approach.

In Chapter 3, the analysis methods included in the software are described. The descriptions of the methods are divided into time-domain, frequency-domain, nonlinear, and time-varying categories and a summary of the methods is given at the end of the chapter. For most of the methods, exact formulas for the different variables are given and possible parameter selections are pointed out.

In Chapter 4, the description of the features and usage of the software is given. First, the input data formats supported by the software are described and then the user interface through which the software is operated is described. Then, different options for saving the analysis results are described and, finally, instructions on how to set up the preference values for the analysis options are given.

In Chapter 5, two sample runs of the software are presented. The first sample run describes how to analyze the lying and standing periods of the orthostatic test measurement (distributed along this software) separately as stationary segments. The second sample run, on the other hand, describes the time-varying analysis procedure of the same measurement.

In Appendix A, some frequently asked questions with answers are given. The questions are selected based on the feedback obtained from the users of the previous version of this software.

Finally, in Appendix B, workarounds for some commonly encountered technical problems are given.
Chapter 2

Heart rate variability

Heart rate variability (HRV) describes the variations between consecutive heartbeats. The rhythm of the heart is controlled by the sinoatrial (SA) node, which is modulated by both the sympathetic and parasympathetic branches of the autonomic nervous system. Sympathetic activity tends to increase heart rate (HR↑) and its response is slow (few seconds) \[3\]. Parasympathetic activity, on the other hand, tends to decrease heart rate (HR↓) and mediates faster (0.2–0.6 seconds) \[3\]. In addition to central control, there are some feedback mechanisms that can provide quick reflexes. One such mechanism is the arterial baroreflex. This reflex is based on baroreceptors which are located on the walls of some large vessels and can sense the stretching of vessel walls caused by pressure increase. Both sympathetic and parasympathetic activity are influenced by baroreceptor stimulation through a specific baroreflex arc, Fig. 2.1.

The continuous modulation of the sympathetic and parasympathetic innervations results in variations in heart rate. The most conspicuous periodic component of HRV is the so-called respiratory sinus arrhythmia (RSA) which is considered to range from 0.15 to 0.4 Hz \[3\]. In addition to the physiological influence of breathing on HRV, this high frequency (HF) component is generally believed to be of parasympathetic origin. Another widely studied component of HRV is the low frequency (LF) component usually ranging from 0.04 to 0.15 Hz including the component referred to as the 10-second rhythm or the Mayer wave \[3\]. The rhythms within the LF band have been thought to be of both sympathetic and parasympathetic origin \[3\] even though some researchers have suggested them to be mainly of sympathetic origin \[25\]. The fluctuations below 0.04 Hz, on the other hand, have not been studied as much as the higher frequencies. These frequencies are commonly divided into very low frequency (VLF, 0.003-0.04 Hz) and ultra low frequency (ULF, 0-0.003 Hz) bands, but in case of short-term recordings the ULF band is generally omitted \[44\]. These lowest frequency rhythms are characteristic for HRV signals and have been related to, e.g., humoral factors such as the thermoregulatory processes and renin-angiotensin system \[3\].

Even though HRV has been studied extensively during the last decades within which numerous research articles have been published, the practical use of HRV have reached general consensus only in two clinical applications \[44\]. That is, it can be used as a predictor of risk after myocardial infarction \[24, 18\] and as an early warning sign of diabetic neuropathy \[4, 33\]. In addition, HRV has been found to correlate with, e.g., age, mental and physical stress, and attention, see, e.g., the review in \[3\].

The term HRV refers, in general, to changes in heart beat interval which is a reciprocal of the heart rate. This is also the case here. The starting point for HRV analysis is the ECG recording from which the HRV time series can be extracted. In the formulation of the HRV
2.1 Heart beat period and QRS detection

The aim in HRV analysis is to examine the sinus rhythm modulated by the autonomic nervous system. Therefore, one should technically detect the occurrence times of the SA-node action potentials. This is, however, practically impossible and, thus, the fiducial points for the heart beat is usually determined from the ECG recording. The nearest observable activity in the ECG compared to SA-node firing is the P-wave resulting from atrial depolarization (see Fig. 2.2) and, thus, the heart beat period is generally defined as the time difference between two successive P-waves. The signal-to-noise ratio of the P-wave is, however, clearly lower than that of the strong QRS complex which results primarily from ventricular depolarization. Therefore, the heart beat period is commonly evaluated as the time difference between the easily detectable QRS complexes.

A typical QRS detector consists of a preprocessing part followed by a decision rule. Several different QRS detectors have been proposed within last decades [45, 34, 35, 16, 11]. For an easy to read review of these methods, see [1]. The preprocessing of the ECG usually includes at least bandpass filtering to reduce power line noise, baseline wander, muscle noise, and other interference components. The passband can be set to approximately 5–30 Hz which covers most of the frequency content of QRS complex [34]. In addition, preprocessing can include differentiation and/or squaring of the samples. After preprocessing, the decision rules are applied to determine whether or not a QRS complex has occurred. The decision rule usually includes an amplitude threshold which is adjusted adaptively as the detection progresses. In addition, the average heart beat period is often used in the decision. The fiducial point is generally selected to be the R-wave and the corresponding time instants are given as the output of the detector.

The accuracy of the R-wave occurrence time estimates is often required to be 1–2 ms and, thus, the sampling frequency of the ECG should be at least 500–1000 Hz [44]. If the

![Figure 2.1: The four baroreflex pathways (redrawn from [41]). Variation in venous volume ($\Delta V_v$), left ventricular contractility (VC), sympathetic and parasympathetic (vagal) control of heart rate (HR), stroke volume ($V_s$), cardiac output (CO), total peripheral resistance (TPR), and arterial blood pressure ($BP_a$).]
sampling frequency of the ECG is less than 500 Hz, the errors in R-wave occurrence times can cause critical distortion to HRV analysis results, especially to spectrum estimates [30]. The distortion of the spectrum is even bigger if the overall variability in heart rate is small [38]. The estimation accuracy can, however, be improved by interpolating the QRS complex, e.g., by using a cubic spline interpolation [8]. It should be, however, noted that when the SA-node impulses are of interest there is an unavoidable estimation error of approximately 3 ms due to fluctuations in the AV-nodal conduction time [41].

2.2 Derivation of HRV time series

After the QRS complex occurrence times have been estimated, the HRV time series can be derived. The inter-beat intervals or RR intervals are obtained as differences between successive R-wave occurrence times. That is, the $n$'th RR interval is obtained as the difference between the R-wave occurrence times $\text{RR}_n = t_n - t_{n-1}$. In some context, normal-to-normal (NN) may also be used when referring to these intervals indicating strictly intervals between successive QRS complexes resulting from SA-node depolarization [44]. In practice, the NN and RR intervals appear to be the same and, thus, the term RR is preferred here.

The time series constructed from all available RR intervals is, clearly, not equidistantly sampled, but has to be presented as a function of time, i.e. as values $(t_n, \text{RR}_n)$. This fact has to be taken into account before frequency-domain analysis. In general, three different approaches have been used to get around this issue [44]. The simplest approach that have been adopted in, e.g., [2] is to assume equidistant sampling and calculate the spectrum directly from the RR interval tachogram (RR intervals as a function of beat number), see the left panel of Fig. 2.3. This assumption can, however, cause distortion into the spectrum
2.3 Preprocessing of HRV time series

Any artifact in the RR interval time series may interfere the analysis of these signals. The artifacts within HRV signals can be divided into technical and physiological artifacts. The technical artifacts can include missing or additional QRS complex detections and errors in R-wave occurrence times. These artifacts may be due to measurement artifacts or the computational algorithm. The physiological artifacts, on the other hand, include ectopic beats and arrhythmic events. In order to avoid the interference of such artifacts, the ECG recording and the corresponding event series should always be manually checked for artifacts and only artifact-free sections should be included in the analysis [44]. Alternatively, if the

---

Kubios HRV Analysis
version 2.0 beta

Biosignal Analysis and Medical Imaging Group
Department of Physics
University of Kuopio, FINLAND
amount of artifact-free data is insufficient, proper interpolation methods can be used to reduce these artifacts, see, e.g., [21, 22, 29].

Another common feature that can alter the analysis significantly are the slow linear or more complex trends within the analyzed time series. Such slow nonstationarities are characteristic for HRV signals and should be considered before the analysis. The origins of nonstationarities in HRV are discussed, e.g., in [3]. Two kinds of methods have been used to get around the nonstationarity problem. In [48], it was suggested that HRV data should be systematically tested for nonstationarities and that only stationary segments should be analyzed. Representativeness of these segments in comparison with the whole HRV signal was, however, questioned in [14]. Other methods try to remove the slow nonstationary trends from the HRV signal before analysis. The detrending is usually based on first order [23, 31] or higher order polynomial [39, 31] models. In addition, this software includes an advanced detrending procedure originally presented in [43]. This approach is based on smoothness priors regularization.

### 2.3.1 Smoothness priors based detrending approach

Let \( z \in \mathbb{R}^N \) denote the RR interval time series which can be considered to consist of two components

\[
z = z_{\text{stat}} + z_{\text{trend}} \tag{2.1}
\]

where \( z_{\text{stat}} \) is the nearly stationary RR interval series of interest, \( z_{\text{trend}} \) is the low frequency aperiodic trend component, and \( N \) is the number of RR intervals. Suppose that the trend component can be modeled with a linear observation model as

\[
z_{\text{trend}} = H\theta + e \tag{2.2}
\]

where \( H \in \mathbb{R}^{N \times p} \) is the observation matrix, \( \theta \in \mathbb{R}^p \) are the regression parameters, and \( e \) is the observation error. The task is then to estimate the parameters by some fitting procedure so that \( \hat{z}_{\text{trend}} = H\hat{\theta} \) can be used as the estimate of the trend. The properties of the estimate depend strongly on the properties of the basis vectors (columns of the matrix \( H \)) in the fitting. A widely used method for the solution of the estimate \( \hat{\theta} \) is the least squares method. However, a more general approach for the estimation of \( \hat{\theta} \) is used here. That is, the so-called regularized least squares solution

\[
\hat{\theta}_\lambda = \arg \min_{\theta} \left\{ \|z - H\theta\|^2 + \lambda^2 \|D_d(H\theta)\|^2 \right\} \tag{2.3}
\]

where \( \lambda \) is the regularization parameter and \( D_d \) indicates the discrete approximation of the \( d \)'th derivative operator. This is clearly a modification of the ordinary least squares solution to the direction in which the side norm \( \|D_d(H\theta)\| \) gets smaller. In this way, prior information about the predicted trend \( H\theta \) can be implemented to the estimation. The solution of (2.3) can be written in the form

\[
\hat{\theta}_\lambda = (H^T H + \lambda^2 H^T D_d^T D_d H)^{-1} H^T z \tag{2.4}
\]

and the estimate for the trend which is to be removed as

\[
\hat{z}_{\text{trend}} = H\hat{\theta}_\lambda. \tag{2.5}
\]

The selection of the observation matrix \( H \) can be implemented according to some known properties of the data \( z \). For example, a generic set of Gaussian shaped functions or sigmoids can be used. Here, however, the trivial choice of identity matrix \( H = I \in \mathbb{R}^{N \times N} \) is used.
2.3. Preprocessing of HRV time series

Figure 2.4: a) Time-varying frequency response of $L$ ($N = 50$ and $\lambda = 10$). Only the first half of the frequency response is presented, since the other half is identical. b) Frequency responses, obtained from the middle row of $L$ (cf. bold lines), for $\lambda = 1, 2, 4, 10, 20, 100,$ and 500. The corresponding cut-off frequencies are 0.213, 0.145, 0.101, 0.063, 0.045, 0.021 and 0.010 times the sampling frequency.

In this case, the regularization part of (2.3) can be understood to draw the solution towards the null space of the regularization matrix $D_d$. The null space of the second order difference matrix contains all first order curves and, thus, $D_2$ is a good choice for estimating the aperiodic trend of RR series. With these specific choices, the detrended nearly stationary RR series can be written as

$$\hat{z}_{\text{stat}} = z - H\hat{\theta}_\lambda = (I - (I + \lambda^2D_2^T D_2)^{-1})z.$$  

(2.6)

In order to demonstrate the properties of the proposed detrending method, its frequency response is considered. Equation (2.5) can be written as $\hat{z}_{\text{stat}} = Lz$, where $L = I - (I + \lambda^2D_2^T D_2)^{-1}$ corresponds to a time-varying finite impulse response highpass filter. The frequency response of $L$ for each discrete time point, obtained as a Fourier transform of its rows, is presented in Fig. 2.4 (a). It can be seen that the filter is mostly constant but the beginning and end of the signal are handled differently. The filtering effect is attenuated for the first and last elements of $z$ and, thus, the distortion of end points of data is avoided. The effect of the smoothing parameter $\lambda$ on the frequency response of the filter is presented in Fig. 2.4 (b). The cutoff frequency of the filter decreases when $\lambda$ is increased. Besides the $\lambda$ parameter the frequency response naturally depends on the sampling rate of signal $z$. 
Chapter 3

Analysis methods

In this chapter, the analysis methods used in the software are introduced. The presented methods are mainly based on the guidelines given in [44]. The presentation of the methods is divided into four categories, i.e. time-domain, frequency-domain, nonlinear, and time-varying methods. The methods summarized in Table 3.1.

3.1 Time-domain methods

The time-domain methods are the simplest to perform since they are applied straight to the series of successive RR interval values. The most evident such measure is the mean value of RR intervals (RR) or, correspondingly, the mean HR (HR). In addition, several variables that measure the variability within the RR series exist. The standard deviation of RR intervals (SDNN) is defined as

$$SDNN = \sqrt{\frac{1}{N-1} \sum_{j=1}^{N} (RR_j - \bar{RR})^2}$$  \hspace{1cm} (3.1)

where RR\textsubscript{j} denotes the value of j'th RR interval and N is the total number of successive intervals. The SDNN reflects the overall (both short-term and long-term) variation within the RR interval series, whereas the standard deviation of successive RR interval differences (SDSD) given by

$$SDSD = \sqrt{E\{\Delta RR_j^2\} - E\{\Delta RR_j\}^2}$$  \hspace{1cm} (3.2)

can be used as a measure of the short-term variability. For stationary RR series $E\{\Delta RR_j\} = E\{RR_{j+1}\} - E\{RR_j\} = 0$ and SDSD equals the root mean square of successive differences (RMSSD) given by

$$RMSSD = \sqrt{\frac{1}{N-1} \sum_{j=1}^{N-1} (RR_{j+1} - RR_j)^2}.$$  \hspace{1cm} (3.3)

Another measure calculated from successive RR interval differences is the NN50 which is the number of successive intervals differing more than 50 ms or the corresponding relative amount

$$pNN50 = \frac{NN50}{N-1} \times 100\%.$$  \hspace{1cm} (3.4)
In addition to the above statistical measures, there are some geometric measures that are calculated from the RR interval histogram. The HRV triangular index is obtained as the integral of the histogram (i.e., total number of RR intervals) divided by the height of the histogram which depends on the selected bin width. In order to obtain comparable results, a bin width of 1/128 seconds is recommended [44]. Another geometric measure is the TINN which is the baseline width of the RR histogram evaluated through triangular interpolation, see [44] for details.

3.2 Frequency-domain methods

In the frequency-domain methods, a power spectrum density (PSD) estimate is calculated for the RR interval series. The regular PSD estimators implicitly assume equidistant sampling and, thus, the RR interval series is converted to equidistantly sampled series by interpolation methods prior to PSD estimation. In the software a cubic spline interpolation method is used. In HRV analysis, the PSD estimation is generally carried out using either FFT based methods or parametric AR modeling based methods. For details on these methods see, e.g., [27]. The advantage of FFT based methods is the simplicity of implementation, while the AR spectrum yields improved resolution especially for short samples. Another property of AR spectrum that has made it popular in HRV analysis is that it can be factorized into separate spectral components. The disadvantages of the AR spectrum are the complexity of model order selection and the contingency of negative components in the spectral factorization. Nevertheless, it may be advantageous to calculate the spectrum with both methods to have comparable results.

In this software, the HRV spectrum is calculated with FFT based Welch’s periodogram method and with the AR method. Spectrum factorization in AR method is optional. In the Welch’s periodogram method the HRV sample is divided into overlapping segments. The spectrum is then obtained by averaging the spectra of these segments. This method decreases the variance of the FFT spectrum.

The generalized frequency bands in case of short-term HRV recordings are the very low frequency (VLF, 0–0.04 Hz), low frequency (LF, 0.04–0.15 Hz), and high frequency (HF, 0.15–0.4 Hz). The frequency-domain measures extracted from the PSD estimate for each frequency band include absolute and relative powers of VLF, LF, and HF bands, LF and HF band powers in normalized units, the LF/HF power ratio, and peak frequencies for each band (see Table 3.1). In the case of FFT spectrum, absolute power values for each frequency band are obtained by simply integrating the spectrum over the band limits. In the case of AR spectrum, on the other hand, if factorization is enabled distinct spectral components emerge for each frequency band with a proper selection of the model order and the absolute power values are obtained directly as the powers of these components. If factorization is disabled the AR spectrum powers are calculated as for the FFT spectrum. The band powers in relative and normalized units are obtained from the absolute values as described in Table 3.1.

3.3 Nonlinear methods

Considering the complex control systems of the heart it is reasonable to assume that nonlinear mechanisms are involved in the genesis of HRV. The nonlinear properties of HRV have been analyzed using measures such as Poincaré plot [5, 6], approximate and sample entropy [40, 12], detrended fluctuation analysis [36, 37], correlation dimension [15, 17], and...
Figure 3.1: Poincaré plot analysis with the ellipse fitting procedure. SD1 and SD2 are the standard deviations in the directions $x_1$ and $x_2$, where $x_2$ is the line-of-identity for which $RR_j = RR_{j+1}$.

recurrence plots [47, 46, 49]. During the last years, the number of studies utilizing such methods have increased substantially. The downside of these methods is still, however, the difficulty of physiological interpretation of the results.

### 3.3.1 Poincaré plot

One commonly used nonlinear method that is simple to interpret is the so-called Poincaré plot. It is a graphical representation of the correlation between successive RR intervals, i.e. plot of $RR_{j+1}$ as a function of $RR_j$ as described in Fig. 3.1. The shape of the plot is the essential feature. A common approach to parameterize the shape is to fit an ellipse to the plot as shown in Fig. 3.1. The ellipse is oriented according to the line-of-identity ($RR_j = RR_{j+1}$) [5]. The standard deviation of the points perpendicular to the line-of-identity denoted by SD1 describes short-term variability which is mainly caused by RSA. It can be shown that SD1 is related to the time-domain measure SDSD according to [5]

$$SD1^2 = \frac{1}{2} SDSD^2.$$  \hfill (3.5)

The standard deviation along the line-of-identity denoted by SD2, on the other hand, describes long-term variability and has been shown to be related to time-domain measures SDNN and SDSD by [5]

$$SD2^2 = 2 SDNN^2 - \frac{1}{2} SDSD^2.$$  \hfill (3.6)

The standard Poincaré plot can be considered to be of the first order. The second order plot would be a three dimensional plot of values ($RR_j, RR_{j+1}, RR_{j+2}$). In addition, the lag can be bigger than 1, e.g., the plot ($RR_j, RR_{j+2}$).
3.3. Nonlinear methods

3.3.2 Approximate entropy

Approximate entropy (ApEn) measures the complexity or irregularity of the signal [12, 40]. Large values of ApEn indicate high irregularity and smaller values of ApEn more regular signal. The ApEn is computed as follows.

First, a set of length \( m \) vectors \( u_j \) is formed

\[
u_j = (RR_j, RR_{j+1}, \ldots, RR_{j+m-1}), \quad j = 1, 2, \ldots, N - m + 1
\]

(3.7)

where \( m \) is called the embedding dimension and \( N \) is the number of measured RR intervals. The distance between these vectors is defined as the maximum absolute difference between the corresponding elements, i.e.,

\[
d(u_j, u_k) = \max \{|RR_{j+n} - RR_{k+n}| \mid n = 0, \ldots, m - 1\}
\]

(3.8)

Next, for each \( u_j \) the relative number of vectors \( u_k \) for which \( d(u_j, u_k) \leq r \) is calculated. This index is denoted with \( C_m^j(r) \) and can be written in the form

\[
C_m^j(r) = \frac{\text{nrb of } \{u_k \mid d(u_j, u_k) \leq r\}}{N - m + 1} \quad \forall k.
\]

(3.9)

Due to the normalization, the value of \( C_m^j(r) \) is always smaller or equal to 1. Note that the value is, however, at least \( 1/(N - m + 1) \) since \( u_j \) is also included in the count. Then, take the natural logarithm of each \( C_m^j(r) \) and average over \( j \) to yield

\[
\Phi_m(r) = \frac{1}{N - m + 1} \sum_{j=1}^{N-m+1} \ln C_m^j(r).
\]

(3.10)

Finally, the approximate entropy is obtained as

\[
\text{ApEn}(m, r, N) = \Phi_m(r) - \Phi^{m+1}(r).
\]

(3.11)

Thus, the value of the estimate ApEn depends on three parameters, the length \( m \) of the vectors \( u_j \), the tolerance value \( r \), and the data length \( N \). In this software the value of \( m \) is selected to be \( m = 2 \). The length \( N \) of the data also affects ApEn. When \( N \) is increased the ApEn approaches its asymptotic value. The tolerance \( r \) has a strong effect on ApEn and it should be selected as a fraction of the standard deviation of the data (SDNN). This selection enables the comparison of different data types. A common selection for \( r \) is \( r = 0.2 \text{SDNN} \), which is also used in this software.

3.3.3 Sample entropy

Sample entropy (SampEn) is similar to ApEn, but there are two important differences in its calculation [40, 20]. For ApEn, in the calculation of the number of vectors \( u_k \) for which \( d(u_j, u_k) \leq r \) also the vector \( u_j \) itself is included. This ensures that \( C_m^j(r) \) is always larger than 0 and the logarithm can be applied, but at the same time it makes ApEn to be biased. In sample entropy the self-comparison of \( u_j \) is eliminated by calculating \( C_m^j(r) \) as

\[
C_m^j(r) = \frac{\text{nrb of } \{u_k \mid d(u_j, u_k) \leq r\}}{N - m} \quad \forall k \neq j.
\]

(3.12)
3.3. Nonlinear methods

Now the value of $C^m_j(r)$ will be between 0 and 1. Next, the values of $C^m_j(r)$ are averaged to yield

$$C^m(r) = \frac{1}{N - m + 1} \sum_{j=1}^{N-m+1} C^m_j(r) \tag{3.13}$$

and the sample entropy is obtained as

$$\text{SampEn}(m, r, N) = \ln \left( \frac{C^m(r)}{C^{m+1}(r)} \right). \tag{3.14}$$

The values selected for the embedding dimension $m$ and for the tolerance parameter $r$ in the software are the same as those for the approximate entropy calculation. Both ApEn and SampEn are estimates for the negative natural logarithm of the conditional probability that a data of length $N$, having repeated itself within a tolerance $r$ for $m$ points, will also repeat itself for $m + 1$ points. SampEn was designed to reduce the bias of ApEn and has a closer agreement with the theory for data with known probabilistic content [20].

3.3.4 Detrended fluctuation analysis

Detrended fluctuation analysis (DFA) measures the correlation within the signal. The correlation is extracted for different time scales as follows [36]. First, the RR interval time series is integrated

$$y(k) = \sum_{j=1}^{k} (RR_j - \bar{RR}), \quad k = 1, \ldots, N \tag{3.15}$$

where $\bar{RR}$ is the average RR interval. Next, the integrated series is divided into segments of equal length $n$. Within each segment, a least squares line is fitted into the data. Let $y_n(k)$ denote these regression lines. Next the integrated series $y(k)$ is detrended by subtracting the local trend within each segment and the root-mean-square fluctuation of this integrated and detrended time series is calculated by

$$F(n) = \sqrt{\frac{1}{N} \sum_{k=1}^{N} (y(k) - y_n(k))^2}. \tag{3.16}$$

This computation is repeated over different segment lengths to yield the index $F(n)$ as a function of segment length $n$. Typically $F(n)$ increases with segment length. A linear relationship on a double log graph indicates presence of fractal scaling and the fluctuations can be characterized by scaling exponent $\alpha$ (the slope of the regression line relating log $F(n)$ to log $n$). Different values of $\alpha$ indicate the following

- $\alpha = 1.5$: Brown noise (integral of white noise)
- $1 < \alpha < 1.5$: Different kinds of noise
- $\alpha = 1$: $1/f$ noise
- $0.5 < \alpha < 1$: Large values are likely to be followed by large value and vice versa
- $\alpha = 0.5$: White noise
- $0 < \alpha < 0.5$: Large value is likely to be followed by small value and vice versa

Typically, in DFA the correlations are divided into short-term and long-term fluctuations. In the software, the short-term fluctuations are characterized by the slope $\alpha_1$ obtained from the $(\log n, \log F(n))$ graph within range $4 \leq n \leq 16$. Correspondingly, the slope $\alpha_2$ obtained from the range $16 \leq n \leq 64$ characterizes long-term fluctuations, see Fig. 3.2.
3.3 Nonlinear methods

3.3.5 Correlation dimension

Another method for measuring the complexity or strangeness of the time series is the correlation dimension which was proposed in [13]. The correlation dimension is expected to give information on the minimum number of dynamic variables needed to model the underlying system and it can be obtained as follows.

Similarly as in the calculation of approximate and sample entropies, form length $m$ vectors $u_j$

$$u_j = (RR_j, RR_{j+1}, \ldots, RR_{j+m-1}), \quad j = 1, 2, \ldots, N - m + 1$$  \hspace{1cm} (3.17)

and calculate the number of vectors $u_k$ for which $d(u_j, u_k) \leq r$, that is

$$C^m_j(r) = \frac{\text{nbr of } \{u_k \mid d(u_j, u_k) \leq r\}}{N - m + 1} \quad \forall k$$  \hspace{1cm} (3.18)

where the distance function $d(u_j, u_k)$ is now defined as

$$d(u_j, u_k) = \sqrt{\sum_{l=1}^{m} (u_j(l) - u_k(l))^2}.$$  \hspace{1cm} (3.19)

Next, an average of the term $C^m_j(r)$ is taken

$$C^m(r) = \frac{1}{N - m + 1} \sum_{j=1}^{N-m+1} C^m_j(r)$$  \hspace{1cm} (3.20)

Figure 3.2: Detrended fluctuation analysis. A double log plot of the index $F(n)$ as a function of segment length $n$. $\alpha_1$ and $\alpha_2$ are the short term and long term fluctuation slopes, respectively.
Figure 3.3: Approximation of the correlation dimension $D_2$ from the $(\log r, \log C_m(r))$ plot.

which is the so-called correlation integral. The correlation dimension $D_2$ is defined as the limit value

$$D_2(m) = \lim_{r \to 0} \lim_{N \to \infty} \frac{\log C_m(r)}{\log r}.$$  (3.21)

In practice this limit value is approximated by the slope of the regression curve $(\log r, \log C_m(r))$ [17]. The slope is calculated from the linear part of the log-log plot, see Fig. 3.3. The slope of the regression curves tend to saturate on the finite value of $D_2$ when $m$ is increased. In the software, a value of $m = 10$ was selected for the embedding.

### 3.3.6 Recurrence plot analysis

Yet another approach, included in the software, for analyzing the complexity of the time series is the so-called recurrence plot (RP) analysis. In this approach, vectors

$$u_j = (RR_j, RR_{j+\tau}, \ldots, RR_{j+(m-1)\tau}), \quad j = 1, 2, \ldots, N - (m-1)\tau$$  (3.22)

where $m$ is the embedding dimension and $\tau$ the embedding lag. The vectors $u_j$ then represent the RR interval time series as a trajectory in $m$ dimensional space. A recurrence plot is a symmetrical $[N - (m-1)\tau] \times [N - (m-1)\tau]$ matrix of zeros and ones. The element in the $j$’th row and $k$’th column of the RP matrix, i.e. $RP(j,k)$, is 1 if the point $u_j$ on the trajectory is close to point $u_k$. That is

$$RP(j,k) = \begin{cases} 1, & d(u_j - u_k) \leq r \\ 0, & \text{otherwise} \end{cases}$$  (3.23)

where $d(u_j, u_k)$ is the Euclidean distance given in (3.19) and $r$ is a fixed threshold. The structure of the RP matrix usually shows short line segments of ones parallel to the main diagonal. The lengths of these diagonal lines describe the duration of which the two points are close to each other. An example RP for HRV time series is presented in Fig. 3.4.
3.3. Nonlinear methods

Methods for quantifying recurrence plots were proposed in [47]. The methods included in this software are introduced below.

In the software the following selections were made. The embedding dimension and lag were selected to be \( m = 10 \) and \( \tau = 1 \), respectively. The threshold distance \( r \) was selected to be \( \sqrt{m} \text{SD} \), where SD is the standard deviation of the RR time series. The selection are similar to those made in [7].

The first quantitative measure of RP is the recurrence rate (REC) which is simply the ratio of ones and zeros in the RP matrix. The number of elements in the RP matrix for \( \tau = 1 \) is equal to \( N - m + 1 \) and the recurrence rate is simply given as

\[
\text{REC} = \frac{1}{(N - m + 1)^2} \sum_{j,k=1}^{N-m+1} \text{RP}(j,k).
\] (3.24)

The recurrence rate can also be calculated separately for each diagonal parallel to the line-of-identity (main diagonal). The trend of REC as a function of the time distance between these diagonals and the line-of-identity describes the fading of the recurrences for points further away.

The rest of the RP measures consider the lengths of the diagonal lines. A threshold \( l_{\text{min}} = 2 \) is used for excluding the diagonal lines formed by tangential motion of the trajectory. The maximum line length is denoted \( l_{\text{max}} \) and its inverse, the divergence,

\[
\text{DIV} = \frac{1}{l_{\text{max}}} \] (3.25)

has been shown to correlate with the largest positive Lyapunov exponent [46]. The average diagonal line length, on the other hand, is obtained as

\[
l_{\text{mean}} = \frac{\sum_{l=l_{\text{min}}}^{l_{\text{max}}} N_l l}{\sum_{l=l_{\text{min}}}^{l_{\text{max}}} N_l}
\] (3.26)
where \( N_l \) is the number of length \( l \) lines. The determinism of the time series is measured by the variable

\[
DET = \frac{\sum_{l=l_{\text{min}}}^{l_{\text{max}}} lN_l}{\sum_{j,k=1}^{N-m+1} \text{RP}(j,k)}.
\]

(3.27)

Finally, the Shannon information entropy of the line length distribution is defined as

\[
\text{ShanEn} = - \sum_{l=l_{\text{min}}}^{l_{\text{max}}} n_l \ln n_l
\]

(3.28)

where \( n_l \) is the number of length \( l \) lines divided by the total number of lines, that is

\[
n_l = \frac{N_l}{\sum_{l'=l_{\text{min}}}^{l_{\text{max}}} N_{l'}}.
\]

(3.29)

### 3.4 Time-varying methods

The time-varying methods of the software include the trends of the time-domain measures RR, SDNN, HR, SD of HR, RMSSD, NN50, and pNN50. For frequency-domain measures the trends are obtained for VLF, LF, and HF peak frequencies, VLF, LF, and HF band powers, and LF/HF ratio. In addition, trends are calculated for the nonlinear measures ApEn and SampEn. The trends for the time-domain and nonlinear measures are obtained by using a moving window the length and shift of which can be changed.

The frequency-domain measures trends are, instead, obtained from a time-varying spectrum estimate. The time-varying spectrum is estimated either by using the moving window FFT, which is also known as the spectrogram method, or with the Kalman smoother algorithm. The Kalman smoother algorithm is an iterative algorithm for estimating the parameters of a time-varying model. In the software, a time-varying AR model is used to model the HRV signal. The adaptation of the Kalman smoother algorithm affecting on the resolution of the spectrum can also be altered.

### 3.5 Summary of HRV parameters

The presented time-domain, frequency-domain, nonlinear, and time-varying measures of HRV calculated by the software are summarized in Table 3.1. For each measure, preferred units and a short description is given. In addition, a reference to the equation in which the specific measure is defined is given when possible and related references are given for some of the measures.
### 3.5. Summary of HRV parameters

Table 3.1: Summary of the HRV measures calculated by the software

<table>
<thead>
<tr>
<th>Measure</th>
<th>Units</th>
<th>Description</th>
<th>References</th>
</tr>
</thead>
<tbody>
<tr>
<td>RR</td>
<td>[ms]</td>
<td>The mean of RR intervals</td>
<td></td>
</tr>
<tr>
<td>STD RR (SDNN)</td>
<td>[ms]</td>
<td>Standard deviation of RR intervals [Eq. (3.1)]</td>
<td></td>
</tr>
<tr>
<td>HR</td>
<td>[1/min]</td>
<td>The mean heart rate</td>
<td></td>
</tr>
<tr>
<td>STD HR</td>
<td>[1/min]</td>
<td>Standard deviation of instantaneous heart rate values</td>
<td></td>
</tr>
<tr>
<td>RMSSD</td>
<td>[ms]</td>
<td>Square root of the mean squared differences between successive RR intervals [Eq. (3.3)]</td>
<td></td>
</tr>
<tr>
<td>NN50</td>
<td></td>
<td>Number of successive RR interval pairs that differ more than 50 ms</td>
<td></td>
</tr>
<tr>
<td>pNN50</td>
<td>[%]</td>
<td>NN50 divided by the total number of RR intervals [Eq. (3.4)]</td>
<td></td>
</tr>
<tr>
<td>HRV triangular</td>
<td></td>
<td>The integral of the RR interval histogram divided by the height of the histogram</td>
<td>44</td>
</tr>
<tr>
<td>TINN</td>
<td>[ms]</td>
<td>Baseline width of the RR interval histogram</td>
<td></td>
</tr>
</tbody>
</table>

#### Time-Domain

- **Peak frequency** [Hz]: VLF, LF, and HF band peak frequencies
- **Absolute power** [ms²]: Absolute powers of VLF, LF, and HF bands
- **Relative power** [%]: Relative powers of VLF, LF, and HF bands
- **Normalized power** [n.u.]: Powers of LF and HF bands in normalized units
- **LF/HF Ratio**: Ratio between LF and HF band powers

#### Frequency-Domain

- **SD1, SD2** [ms]: The standard deviation of the Poincaré plot perpendicular to (SD1) and along (SD2) the line-of-identity [5, 6]
- **ApEn**: Approximate entropy [Eq. (3.11)] [40, 12]
- **SampEn**: Sample entropy [Eq. (3.14)] [40]
- **D₂**: Correlation dimension [Eq. (3.21)] [15, 17]
- **DFA**: Detrended fluctuation analysis:
  - **α₁**: Short term fluctuation slope [36, 37]
  - **α₂**: Long term fluctuation slope
- **RPA**: Recurrence plot analysis: [47, 7, 49]

#### Nonlinear

- **Line**: Mean line length [Eq. (3.26)]
- **Lmax**: Maximum line length
- **REC**: Recurrence rate [Eq. (3.24)]
- **DET**: Determinism [Eq. (3.27)]
- **ShanEn**: Shannon entropy [Eq. (3.28)]

#### Time-Varying

**Time-domain measures:**
- RR, SDNN, HR, STD HR, RMSSD, NN50, and pNN50

**Frequency-domain measures:**
- Peak frequencies, absolute powers, relative powers, normalized powers, and LF/HF ratio

(Note: Time-varying spectrum is estimated using the spectrogram or Kalman smoother method)

**Nonlinear measures:**
- ApEn and SampEn

---

Kubios HRV Analysis
version 2.0 beta

Biosignal Analysis and Medical Imaging Group
Department of Physics
University of Kuopio, FINLAND
Chapter 4

Software description

4.1 Input data formats

The Kubios HRV Analysis supports the following binary data formats: Neuroscan continuous CNT files (Compumedics Limited), Biopac AcqKnowledge files (Biopac Systems Inc.), and European data format (EDF) files. When any of these data format files are read to the software, Kubios HRV automatically tries to determine the ECG channel from the channel labels. If the ECG channel cannot be determined (or more than one channels are identified as ECG channels), the software prompts the user to select the appropriate channel. Due to internal design restrictions of Kubios HRV, the channel labels should only contain alphabets, numbers, and underscores. If the channel labels contain other characters, such as spaces or plus signs, etc., these characters are changed to underscores. Furthermore, the channel label should start with an alphabet. If this is not the case, “Ch_” is added to the beginning of the channel label.

In addition to the three binary formats, support for ASCII text files is also provided. The input ASCII file can include either RR interval values or ECG data in one or two column format. That is, The RR interval values can be given as

<table>
<thead>
<tr>
<th>Type 1</th>
<th>Type 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.759</td>
<td>0.759</td>
</tr>
<tr>
<td>0.690</td>
<td>1.449</td>
</tr>
<tr>
<td>0.702</td>
<td>2.151</td>
</tr>
<tr>
<td>0.712</td>
<td>2.863</td>
</tr>
<tr>
<td>0.773</td>
<td>3.636</td>
</tr>
</tbody>
</table>

The RR interval values above are given in seconds, but millisecond values can also be given. Correspondingly, the ASCII ECG data should be as
4.1. Input data formats

Figure 4.1: The interface for importing customized ASCII data files into the software.

<table>
<thead>
<tr>
<th>Type 1</th>
<th>Type 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>-0.173</td>
<td>0</td>
</tr>
<tr>
<td>-0.119</td>
<td>0.002</td>
</tr>
<tr>
<td>-0.025</td>
<td>0.004</td>
</tr>
<tr>
<td>0.091</td>
<td>0.006</td>
</tr>
<tr>
<td>0.218</td>
<td>0.008</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

where the first column on the second format type is the time scale in seconds for the ECG data. The sampling rate of this example file is, thus, 500 Hz. If ECG data is given according to the first type, user is requested to enter the sampling rate manually.

In addition to above ASCII text files, a custom ASCII file option is also provided. Using this option you can import ASCII files including header lines and/or several data columns. Once you have selected an input file, an interface for importing the file into Kubios is opened. This interface is shown in Fig. 4.1. Through this interface you can specify the following.
4.2. The user interface

required details corresponding to your data file

- Number of header lines
- Column separator (tab/space, comma, or semicolon)
- Data type (ECG or RR)
- Data column (the ordinal number of data column)
- Data units ($\mu$V, V or mV for ECG / ms or s for RR)
- Time index column (the ordinal number of time indexes)
- Time units (units of time indexes in ms or s)
- ECG sampling rate in Hz (if no time index column defined for ECG).

Once you have specified the above values for your file, press OK to proceed to analysis.

4.2 The user interface

The developed HRV analysis software is operated with a graphical user interface which consists of only one window. This user interface window is shown in Fig. 4.2. The user interface is divided into four segments: 1) the RR interval series options segment on the top left corner, 2) the data browser segment on the top right corner, 3) the analysis options segment on the bottom left corner, and 4) the results view segment on the bottom right corner. Each of these segments are described in Sections 4.2.1, 4.2.2, 4.2.3, and 4.2.4, respectively.

4.2.1 RR interval series options

The RR interval series options shown in Fig. 4.3 include three functions: Artifact correction, Samples for analysis, and Remove trend components. The artifact correction options can be used to correct artifacts from a corrupted RR interval series. The user can select between very low, low, medium, strong, and very strong correction levels. In addition, a custom level in seconds can be set. The corrections to be made on the RR series are displayed on the RR interval axis. To make the corrections press the Apply button. A piecewise cubic spline interpolation method is used in the corrections. You can reverse the correction by pressing the Undo button or by selecting none as the correction level. It should be noted that artifact correction generates missing or corrupted values into the RR series by interpolation and can, thus, cause distortion into the analysis results. If ECG is measured, the corrections should always be done by editing the R-peak marks in the ECG data as described in Section 4.2.2.

In the Samples for analysis options the part(s) of the RR interval series to be analyzed can be selected by editing the Number of samples, Range, End, and Length values. If more than one sample is selected the analysis can be done either for the single samples separately or by merging the samples into one before analysis. This selection is visible under the RR series axis when multiple samples are selected. The range of the samples can also be changed by moving/resizing the patch over the RR series as described in Section 4.2.2.

Sometimes the RR interval time series includes a disturbing low frequency baseline trend component. Detrending options can be used to remove this kind of trend components. Detrending options include removal of the first, second, or third order linear trend or the
4.2. The user interface

4.2.1 Trend removal

The trend can be removed using the so-called smoothness priors method presented in [43]. In the smoothness priors method, the smoothness of the removed trend can be adjusted by editing the Lambda value. The bigger the value of Lambda, the smoother is the removed trend. The trend to be removed from the RRI series is shown over the selected part of the RR series as a red line.

4.2.2 Data browser

The data browser segment shown in Fig. 4.4 displays the measured ECG signal and the extracted RR interval series. It should be noted that if only RR interval data is given as input the ECG axis will not be displayed and the RR series axis will be bigger in size. The ECG and RR interval data can be scrolled with the two sliders. The position of the ECG axis is displayed as a green patch in the RR axis. This patch can also be moved with the left mouse button. The range of both axes can be changed by editing the Range values and also the Y-limits of the axes can be manually changed by editing the edit boxes on the left hand side of the axes. The ECG and RR interval axes can also be scrolled together by locking the axes by pressing the button connecting the Range values.

In addition to the visualization of the ECG and RR interval data, the main function of this segment is to enable correction of corrupted RR interval values. This can be done in...
4.2. The user interface

Figure 4.3: The RR interval series options segment of the user interface.

Figure 4.4: The data browser segment of the user interface.

two ways. If only RR data is available, the artifact corrections described in Section 4.2.1 are displayed in the RR axis. If the ECG is measured, these corrections can be made by editing the misdetected R-peak as follows. Each detected R-peak is marked in the ECG axis with a “+” mark. Each mark can be moved or removed by right clicking it with the mouse (see Fig. 4.4). In addition, new R-peak markers can be added by either right clicking some other marker and selecting Add or by pressing the uppermost button on the right hand side of the ECG axis. Moved or added R-peak markers are by default snapped to closed ECG maximum, but manual positioning can also be achieved by pressing the middle button on the right hand side of the ECG axis. The changes made in R-peak markers will be automatically updated to RR interval series.

The selected sample(s) (yellow patches in the RR axis) can be modified with mouse as follows. Each sample can be moved by grabbing it from the middle with the left mouse button and resized by grabbing it from the left or right edge. When more than one samples are selected, a sample can be removed by right clicking it with the mouse.
4.2. The user interface

In addition, the data browser segment includes buttons for displaying a printout of the ECG recording (on the left hand side of the ECG axis), moving the ECG axis view to the beginning of a selected sample (on the left hand side of the ECG axis), scrolling the markers of the recording session (below the ECG axis), and changing the RR series display mode (on the right hand side of the RR axis). An example of the ECG printout is shown in Fig. 4.5. The ECG signal is displayed in a similar window as the report sheet and has, thus, e.g. the same kind of exporting functions (see Section 4.3.2 for details).

4.2.3 Analysis options

The analysis options segment shown in Fig. 4.6 includes three subcategories: Frequency bands, Interpolation of RR series, and Spectrum estimation. All of these options are concerned with frequency-domain analysis.

The very low frequency (VLF), low frequency (LF), and high frequency (HF) bands of HRV frequency-domain analysis can be adjusted by editing the VLF, LF, and HF values. The default values for the bands are VLF: 0–0.04 Hz, LF: 0.04–0.15 Hz, and HF: 0.15–0.4 Hz according to [44]. The default values for the bands can be restored by pressing the Defaults button.

The RR interval time series is an irregularly time sampled series as discussed in Section 2.2 and, thus, spectrum estimation methods can not be applied directly. In this software, this problem is solved by using interpolation methods for converting the RR series into equidistantly sampled form. As the interpolation method a piecewise cubic spline interpolation is used. The sampling rate of the interpolation can be adjusted by editing the Interpolation rate value. By default a 4 Hz interpolation is used.

The spectrum for the selected RR interval sample is calculated both with Welch’s periodogram method (FFT spectrum) and with an autoregressive modeling based method (AR spectrum). In the Welch’s periodogram method, the used window width and window overlap can be adjusted by editing the corresponding value. The default value for window width is 256 seconds and the default overlap is 50 % (corresponding to 128 seconds). In the AR spectrum, there are also two options that can be selected. First, the order of the used AR model can be selected. The default value for the model order is 16, but the model order should always be at least twice the number of spectral peaks in the data. The second option is whether or not to use spectral factorization in the AR spectrum estimation. In the factorization the AR spectrum is divided into separate components and the power estimates of each component are used for the band powers. The factorization, however, has some serious problems which can distort the results significantly. The main problems are the selection of the model order in such a way that only one AR component will result in each frequency band and, secondly, negative power values can result for closely spaced AR components. Thus, the selection of not to use factorization in AR spectrum is surely more robust and in that sense recommended.

4.2.4 Results view

The results for the selected RR interval sample are displayed in the results view segment. The results are divided into time-domain, frequency-domain, nonlinear, and time-varying results. The results of each section are displayed by pressing the corresponding button on the top of the results view segment. The results are by default updated automatically whenever any one of the the sample or analysis options that effect on the results is changed. The updating of the results can be time consuming for longer samples and in that case it might be useful to disable the automatic update by unchecking the Automatic check box in the
4.2. The user interface

Figure 4.5: The printout of the ECG signal generated by the software.
4.2. The user interface

Figure 4.6: The analysis options segment of the user interface.

![Analysis Options]

Figure 4.7: The results view segment of the user interface: time-domain results view selected.

The time-domain results view shown in Fig. 4.7 displays the time-domain variables in a table and the RR interval and heart rate histograms in the two axes. Most of the results are calculated from the detrended RR series (if detrending is applied), but there are two obvious exceptions (i.e. mean RR interval and mean HR) which are marker with the * symbol.

The frequency-domain results view shown in Fig. 4.8 displays the results for both FFT and AR spectrum estimation methods. Both methods are applied to the detrended RR series. The spectra of the two methods are presented in the two axes (FFT spectrum on the left and AR spectrum on the right). The frequency axes of the spectra are fixed to range from 0 Hz to the upper limit of HF band plus 0.1 Hz. Thus, for the default frequency band settings the frequency axis range is 0–0.5 Hz. The power axes of the spectra, on the other hand, can be adjusted with the options on the upper left corner of the frequency-domain results view. The power axes can be selected to have either common or separate upper
4.2. The user interface

Figure 4.8: The results view segment of the user interface: frequency-domain results view selected.

Figure 4.9: The results view segment of the user interface: nonlinear results view selected.

Y-limits. If common Y-limit is selected, it can also be entered manually into the edit box below the selection button. The selected power axis options apply also for the report sheet. The results for both spectra are displayed in tables below the corresponding spectrum axes.

The nonlinear results view shown in Fig. 4.9 displays all the calculated nonlinear variables in one table. All the variables are calculated from the original non-detrended RR series. The Poincaré plot and the DFA results are also presented graphically in the two axes. In the Poincaré plot (left hand axis), the successive RR intervals are plotted as blue circles and the SD1 and SD2 variables obtained from the ellipse fitting technique are presented (for details see Section 3.3.1). In the DFA plot (right hand axis), the detrended fluctuations $F(n)$ are presented as a function of $n$ in a log-log scale and the slopes for the short term and long term fluctuations $\alpha_1$ and $\alpha_2$, respectively, are indicated (for details see Section 3.3.4).

The time-varying results view shown in Fig. 4.10 displays the time-varying trend of the selected variable. The variable is selected using the two buttons on the lower left hand corner of the view. Selectable variables are divided into time-domain, frequency-domain, and nonlinear categories. The trend of the selected variable will appear immediately in the axis. The line style of the trend can be changed by pressing the button on the right-
4.2. The user interface

4.2.5 Menus and toolbar buttons

The user menus and toolbar buttons are located on the upper left hand corner of the user interface. There are all together three user menus and seven toolbar buttons. The toolbar button icons and their actions are given below.
4.3 Saving the results

Open new data file button is for opening a new data file for analysis. If the results of the current analysis have not been saved, user is prompted to do so.

Save results button is for saving the analysis results. The results can be saved in ASCII, PDF, and MATLAB® MAT file format (see Section 4.3 for details).

Report sheet button opens one or several report sheet windows which include all the analysis results (see Section 4.3.2 for details).

Edit preferences button opens a preferences window in which you can, e.g., change the default values for analysis options (see Section 4.4 for details).

About HRV analysis software button opens the about dialog of the software which includes the version number and contact information. Also the Kubios HRV Analysis End User License Agreement can be viewed in the about dialog.

Open Kubios HRV User’s Guide button opens the Kubios HRV User’s Guide (this document) PDF-file using the default PDF viewer of the system.

Close file button closes the current data file. If the results of the current analysis have not been saved, user is prompted to do so.

All the above actions are also available on the user menus. The File menu includes Open, Save Results, Save Results As, Edit Preferences, Close, and Quit commands. The Open, Save Results, Edit Preferences, and Close commands work exactly as the corresponding toolbar buttons. The difference between the Save and Save As commands is that when the results have already been saved, the Save command automatically overwrites these results, whereas the Save As command asks the user for a new file name. The Quit command of the File menu is for exiting from the software. The View menu includes Markers menu and Report Sheet command. The latter works as the corresponding toolbar button. The Markers menu, on the other hand, is for displaying possible stimuli or event markers presented in the experimental procedure and stored in the data file. If no markers are found from the data file the Markers menu will be disabled. Finally, the Help menu includes the About HRV Analysis Software command which opens the same about dialog as the corresponding toolbar button.

4.3 Saving the results

The analysis results can be saved by selecting Save Results or Save Results As from the File menu or by pressing the save button on the toolbar. This will open a file save dialog in which the saving type can be selected. There are three different types in which the results can be saved. That is, the results can be written in an ASCII text file for further inspection, the report sheets generated from the results can be saved in a PDF-file, or the results can be saved in a MATLAB® MAT-file.

4.3.1 ASCII-file

When the ASCII text file is selected for the saving type, the numeric results of the analysis will be written in an ASCII text file. The resulting text file includes the following information in the enumerated order.
4.3. Saving the results

1. Software, user, and data file informations
2. Used analysis parameters
3. Samples selected for analysis
4. Time-domain results
5. Frequency-domain results
6. Nonlinear results
7. Time-varying results
8. RR interval data and spectrum estimates

The columns of the file are separated with semicolons so that the results could easily be imported to, e.g., spreadsheet programs such as the Microsoft Excel® for further inspection.

4.3.2 Report sheet

The software generates two printable report sheets which present all the analysis results. The first report sheet, shown in Fig. 4.11, includes all the time-domain, frequency-domain, and nonlinear analysis results and the second report sheet, shown in Fig. 4.12, includes all the time-varying analysis results. The RR interval data and the sample selected for analysis are presented on the two axes on top of both sheets and the analysis results below them.

When Save Results have been selected, these report sheets can be saved in a single PDF-file by selecting Report figure as the saving type in the save dialog. In this case, the report sheets will not be displayed, but just saved in the selected PDF-file. If you wish to view the report sheets and/or to export them into some other file format choose Report sheet from the View menu or just press the corresponding toolbar button. This will open the report sheet windows for view.

The report sheet windows include 8 toolbar buttons and File and Page menus on the upper left hand corners of the windows. The toolbar button icons and their actions are given below:

- **Export figure** button opens an export dialog where the report sheet can be exported into one of the various file formats listed in Table 4.1.
- **Print** button opens a print dialog where the report sheet can sent to the selected printer.
- **Export all pages to PDF-file** button is for exporting both report sheets into the selected PDF-file.
- **Zoom in** button if for zooming in (magnifying) the report sheet.
- **Zoom out** button is for zooming out the report sheet.
- **Reset to original size** button can be used to restore the original zoom level. This also resets the size of the corresponding report sheet window to its original size.
- **Move visible area** button is for moving the visible area of the zoomed report sheet in the report window (just grab the sheet with mouse and drag it to the desired direction).
- **Close** button is for closing the report sheet.

The File menu includes Export to, Export All to PDF, Print Current Page, Print All Pages,
4.3. Saving the results

Figure 4.11: The first report sheet including all the time-domain, frequency-domain, and nonlinear analysis results calculated by the software.
4.3. Saving the results

Figure 4.12: The second report sheet including all the time-varying analysis results calculated by the software.
4.3. Saving the results

Table 4.1: Supported file formats to export the report sheet

<table>
<thead>
<tr>
<th>File Format</th>
<th>Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced Metafile</td>
<td>.emf</td>
</tr>
<tr>
<td>Encapsulated Postscript</td>
<td>.eps</td>
</tr>
<tr>
<td>Encapsulated Postscript (color)</td>
<td>.eps</td>
</tr>
<tr>
<td>Encapsulated Postscript (level 2)</td>
<td>.eps</td>
</tr>
<tr>
<td>Encapsulated Postscript (level 2 color)</td>
<td>.eps</td>
</tr>
<tr>
<td>Adobe Illustrator file</td>
<td>.ai</td>
</tr>
<tr>
<td>JPEG image file</td>
<td>.jpg</td>
</tr>
<tr>
<td>TIFF image file</td>
<td>.tif</td>
</tr>
<tr>
<td>TIFF no compression image file</td>
<td>.tif</td>
</tr>
<tr>
<td>Portable Network Graphics file</td>
<td>.png</td>
</tr>
<tr>
<td>Portable Document Format</td>
<td>.pdf</td>
</tr>
</tbody>
</table>

Close, and Close All commands. The Export to, Export All to PDF, Print All Pages, and Close commands are also given as toolbar buttons described above. The last command Close All can be used for closing all report sheets simultaneously. The Edit menu contains only one option, Copy to Clipboard, which copies the contents of the corresponding report sheet window to the Windows clipboard. This can be used to quickly copying the report sheet as an image into another program. The Page menu includes commands for changing for the previous or the next report sheet page (Prev. page and Next page commands, respectively) and for changing the sheet by its page number. However, the Page menu is not shown if only one report sheet window is open.

4.3.3 MATLAB® MAT-file

In addition to saving the numeric results into an ASCII text file or saving the report sheets in a PDF-file, the analysis results can also be saved in a MATLAB® MAT-file (compatible with MATLAB® R12 or higher). The MAT-file includes a single structured array variable named Res. The Res variable includes the numeric results as well as the RR interval data and all the analysis options. This saving option is aimed for MATLAB users and makes the further analysis or processing of the HRV data in MATLAB much easier. The Res structure includes four fields which are shortly described as follows

- **f_name**: File name of the analyzed data file
- **f_path**: Full path for the analyzed data file
- **CNT**: Basic information of the data file (the field name refers to Neuroscan CNT-file for historical reasons)
- **HRV**: Used analysis options, RR interval data, and all analysis results.

The HRV field is clearly the most essential one of these fields. The HRV field includes six fields the contents of which are shortly described as follows

- **Param**: The analysis options used in the calculation of the results
- **Data**: The RR interval data
- **Statistics**: Time-domain analysis results
- **Frequency**: Frequency-domain analysis results
- **NonLinear**: Nonlinear analysis results
- **TimeVar**: Time-varying analysis results.
4.4 Setting up the preferences

Figure 4.13: Set up preferences window of the software: User information category.

The variable names of the different fields are more or less self-descriptive and are not documented here.

4.4 Setting up the preferences

All the analysis options that can be adjusted in the user interface have some default values. These preference values will be used every time the program is started. Any changes made on these values in the user interface only apply for the current session. The preference values are designed to be more or less suitable for short-term HRV recordings and may sometimes need to be redefined. This can be done by selecting Edit Preferences from the File menu or by pressing the corresponding toolbar button. This will open the preferences window in which the preference values can be redefined. The preferences are divided into four categories: User information, Analysis options, Advanced settings, and Report settings.

In the User information category shown in Fig. 4.13 you can set up your personal contact information (Name, Department, and Organization). This information will only be included in the bottom left corner of the report sheet and in the beginning of the ASCII text file including the analysis results. That is, the user information is meant just for indicating the person who has carried out the analysis.

The Analysis options category shown in Fig. 4.14 includes some basic analysis options. The default input data type can be set to one of the file formats mentioned in Section 4.1 and the selected data type will be used as default every time a new data file is opened. The analysis to be performed options include general analysis (i.e. time-domain, frequency-domain, and nonlinear analysis) and time-varying analysis. Only the selected analysis will be performed. For example, if time-varying analysis is not necessary, it can be checked off to speed up the functioning of the software. In addition, the analysis options category includes
### 4.4. Setting up the preferences

RR interval samples, RR interval detrending, HRV frequency bands, and Update analysis results options which have already been described in Sections 4.2.1, 4.2.3, and 4.2.4.

The **Advanced settings category** shown in Fig. 4.15 includes QRS detection, Spectrum estimation, and Time-varying spectrum estimation options. In the QRS detection options you can set up the prior guess for the average RR interval. By default this prior guess is estimated automatically. This may not, however, always work in which case the prior guess for the RR interval value should be fixed to the supposed value. The spectrum estimation options include one additional option compared to those described in Section 4.2.3, i.e. points in frequency-domain option. The point in frequency-domain is given as points/Hz and corresponds by default to the window width of the FFT spectrum. If spectrum interpolation is desired the points in frequency-domain can be increased. The time-varying spectrum estimation options were described in the end of Section 4.2.4.

The **Report settings category** shown in Fig. 4.16 includes two options. First of all, the contents of the report sheet can be selected by checking the General and/or Time-varying results options. If either one of these is unchecked, only one report sheet will be printed. Secondly, the paper size of the report sheet can be changed between A4 (210×297 mm) and Letter (8.5×11 inch) size. The default paper size is A4.

All modifications for the preferences are saved by pressing either the Apply or the OK button. The Apply button applies the modifications to the current session, while the OK saves the preferences, but they will be applied only in the next session. A session is considered to be ended when the program is restarted or Close file is selected. If, on the other hand, a new file is opened (without first closing the previous file) preferences will not be applied, but the local settings (changes made in the user interface) are applied for the new file as well. Note also that by pressing the Apply button in the preferences window your local settings will be replaced with the updated preferences.
4.4. Setting up the preferences

Figure 4.15: Set up preferences window of the software: Advanced settings category.

Figure 4.16: Set up preferences window of the software: Report settings category.
4.4. Setting up the preferences

In addition to the actual analysis options, there are various other editable options which have mainly influence on the usability of the software. Such options are the Range and Y-limit values of the ECG and RR interval axes, the RR series display mode button, Y-limit options for the power spectra, and time-varying results display mode button, color map selection, and displayed variable selections. The values of these options are preserved in memory and, thus, any changes made to them will be applied in the future sessions. Also the preference directories path from where the data file is searched for and in which the results are saved are preserved in memory. The last nine opened data files will also appear in the File menu of the user interface and can be reopened from there.

All the preferences and preserved options used by the software are saved in HRV2 folder located in the user specific Application Data folder. The preference files are found from the folder

C: \Documents and Settings\<username>\Application Data\HRV2

where <username> is the name of your user profile. The folder will include three files: hrv_pref.dat, user_pref.dat, and HRVprefs.mat. The hrv_pref.dat file includes all the preferences for the analysis options, user_pref.dat includes the user information preferences, and HRVprefs.mat all the preferences related to the usability of the software. These files are created when the software is started for the first time and they will be updated whenever the preference values are edited. The original settings of the preferences can, thus, be restored by deleting these files.

---

1 Note that the Application Data folder is hidden by default and is not visible in the Windows File Explorer if the “Show hidden files and folders” is not selected from the “Folder Options” section of the File Explorer.
Chapter 5

Sample runs

In this chapter, we present as an example two sample runs of the software. Both of the sample runs are made for the sample data file distributed with this software. The sample data is measured from a healthy young male during an orthostatic test. The change in the posture is known to be reflected in the low frequency and high frequency HRV in an opposite way. That is, when subject stands up after lying for few minutes a strong decrease in the HF power and a more gradual increase in LF power are observed. In addition, a strong increase in heart rate in observed immediately after standing up, which aims to compensate the sudden decrease in blood pressure. In the first sample run, this data file is analyzed by considering the lying and standing periods separately, whereas in the second sample run we perform a time-varying analysis for the whole measurement.

5.1 Sample run 1: General analysis

In the first sample run, we show how to make the general analysis, i.e. time-domain, frequency-domain, and nonlinear analysis, for the lying and standing periods of the orthostatic measurement separately. This task can be easily accomplished in a single session. First, start the software and open the data file into the user interface. At this point, you can edit any of the analysis options to fit your demands. If you are about to analyze several data files with the same options, you better make these changes straight to the preferences. Here, since we wish to do only general analysis we want to disable the time-varying analysis from the software. To do this select Edit preferences from the File menu and uncheck the time-varying analysis from Analysis options category of the preferences window. Then press the OK button. Now the Time-varying button in the results view segment is disabled and only general analysis will be performed.

The next thing to do is to select the RR interval samples to be analyzed. First, change the number of samples value to 2. This will make two samples shown as yellow patches in the RR interval axes. Then change the sample ranges to cover the periods of interest as shown in Fig. 5.1. The easiest way to change the sampled ranges is to edit them with the mouse as described in Section 4.2.2, but the ranges can also be changed by editing the Range values in RR interval series options segment. Then check that the Sample analysis type option under the RR axis is set for Single samples. Then, analysis results are calculated for both samples separately. If, on the other hand, Merge samples is selected, then the two samples are first merged into one sample and the analysis results are calculated for this merged sample.

Since we are now only interested in the changes in LF and HF bands, we wish to remove
5.1. Sample run 1: General analysis

Sample run 1: General analysis

Figure 5.1: Sample run 1.

the lowest frequency trend components from the RR series. These trend components affect on the time and frequency-domain variables and, thus, by removing the trend from the data enables these variables to better describe the LF and HF variability which we are interested of. We select to remove the trend with the smoothness priors based method. Once the detrending method is selected red lines appear over the RR interval data indicating the removed trend components. The smoothness of the removed trend in the smoothness priors method can be adjusted by changing the Lambda value. The smoothness priors detrending method can be compared to a high-pass filter in which the cutoff frequency is determined from the lambda value (bigger lambda corresponds to lower cutoff). Since we are now interested in LF and HF frequencies, we wish to make sure that the detrending does not remove those frequencies. This can be easily done by changing the Lambda value and looking at the FFT spectrum. Here, we set the Lambda value to 500.

The time-domain, frequency-domain, and nonlinear analysis results for the selected samples can then be viewed in the results view segment. Just make sure that the results have been updated (check that the Automatic is checked in Apply changes and if not press the Apply button). Press the Time-domain, Frequency-domain, or Nonlinear button to view the corresponding results. At first the results are shown for the first sample. To take a look at the results of the second sample press the >> button on the top right corner of the results view segment (the text on the left changes to Sample 2 and the second sample in the RR
5.1. Sample run 1: General analysis

series axis becomes highlighted). Note that you can force a common Y-limit for the spectra of both samples by setting a common Y-limit value manually in the frequency-domain results view. For example, we have here fixed the Y-limit value to 0.04 s²/Hz.

Once we are done with the analysis, we wish to save the analysis results in all possible formats. This can be done by selecting Save Results from the File menu or just by pressing the save button on the toolbar. Then select Save all (*.txt,*.mat,*.pdf) as the save type and enter a file name. You do not need to give any extension to the file name. The numeric results of the analysis will be saved in the *.txt file and in the *.mat MATLAB file and the report sheets in the *.pdf file. The generated PDF-file will now include two pages, one for the results of the first RR interval sample (the lying period) and one for the second sample (standing period). These report sheet pages are shown in Figs. 5.2 and 5.3.

In the text file, the results for the two samples are presented side by side as can be seen from the partial results text file given below.

<table>
<thead>
<tr>
<th>Performed Analysis</th>
<th>General analysis: Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time-varying analysis: No</td>
<td></td>
</tr>
<tr>
<td>RR Interval Samples Selected for Analysis</td>
<td>Sample 1; Sample 2;</td>
</tr>
<tr>
<td>Sample limits (s) :</td>
<td>10-350; 390-720;</td>
</tr>
<tr>
<td>Sample Analysis Type: Single samples</td>
<td></td>
</tr>
</tbody>
</table>

RESULTS FOR SINGLE SAMPLES

GENERAL RESULTS

<table>
<thead>
<tr>
<th>SAMPLE 1</th>
<th>SAMPLE 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time-Domain Results</td>
<td></td>
</tr>
<tr>
<td>Statistical parameters</td>
<td></td>
</tr>
<tr>
<td>Mean RR (ms):</td>
<td>1219.7255; 934.5564;</td>
</tr>
<tr>
<td>STD RR (ms):</td>
<td>45.8613; 42.0675;</td>
</tr>
<tr>
<td>Mean HR (1/min):</td>
<td>49.3307; 64.5556;</td>
</tr>
<tr>
<td>STD HR (1/min):</td>
<td>2.4044; 3.5661;</td>
</tr>
<tr>
<td>RMSSD (ms):</td>
<td>58.8540; 27.9642;</td>
</tr>
<tr>
<td>RRSD (count):</td>
<td>119; 50;</td>
</tr>
<tr>
<td>pNN50 (%):</td>
<td>42.8058; 5.6818;</td>
</tr>
<tr>
<td>SDNN (ms):</td>
<td></td>
</tr>
<tr>
<td>SDNN index (ms):</td>
<td></td>
</tr>
<tr>
<td>Geometric parameters</td>
<td></td>
</tr>
<tr>
<td>RR tri index:</td>
<td>0.084577; 0.088074;</td>
</tr>
<tr>
<td>TINN (ms):</td>
<td>235.0000; 230.0000;</td>
</tr>
<tr>
<td>Frequency-Domain Results</td>
<td>FFT spectrum;AR spectrum;FFT spectrum;AR spectrum;</td>
</tr>
<tr>
<td>Peak frequencies</td>
<td></td>
</tr>
<tr>
<td>VLF (Hz):</td>
<td>0.039063; 0.039063; 0.035156; 0.039063;</td>
</tr>
<tr>
<td>LF (Hz):</td>
<td>0.056594; 0.070313; 0.069844; 0.078125;</td>
</tr>
<tr>
<td>HF (Hz):</td>
<td>0.304688; 0.285156; 0.152344; 0.152344;</td>
</tr>
<tr>
<td>Absolute powers</td>
<td></td>
</tr>
<tr>
<td>VLF (ms²):</td>
<td>154.6365; 286.2022; 526.1911; 196.2865;</td>
</tr>
<tr>
<td>LF (ms²):</td>
<td>556.0111; 764.4204; 1556.0408; 1228.9957;</td>
</tr>
<tr>
<td>HF (ms²):</td>
<td>818.5592; 909.6497; 384.9678; 265.8349;</td>
</tr>
<tr>
<td>Relative powers</td>
<td></td>
</tr>
<tr>
<td>VLF (%)</td>
<td>10.1122; 14.6001; 21.3275; 11.6069;</td>
</tr>
<tr>
<td>LF (%)</td>
<td>36.3594; 38.9956; 63.0691; 72.6736;</td>
</tr>
<tr>
<td>HF (%)</td>
<td>53.5283; 46.4043; 15.6034; 15.7195;</td>
</tr>
<tr>
<td>Normalized powers</td>
<td></td>
</tr>
<tr>
<td>LF (n.u.):</td>
<td>40.4498; 45.6624; 80.1666; 82.2164;</td>
</tr>
<tr>
<td>HF (n.u.):</td>
<td>59.5502; 54.3376; 19.8334; 17.7836;</td>
</tr>
<tr>
<td>LF/HF ratio:</td>
<td>0.6793; 0.8463; 4.0420; 4.6232;</td>
</tr>
<tr>
<td>Nonlinear Results</td>
<td></td>
</tr>
<tr>
<td>Poincare plot</td>
<td></td>
</tr>
<tr>
<td>SD1 (ms):</td>
<td>0.099267; 0.20.192471;</td>
</tr>
<tr>
<td>SD2 (ms):</td>
<td>80.323977; 96.721774;</td>
</tr>
<tr>
<td>Recurrence plot analysis (RPA);</td>
<td></td>
</tr>
<tr>
<td>Mean line length (beats):</td>
<td>8.0360; 14.4666;</td>
</tr>
<tr>
<td>Max line length (beats):</td>
<td>43; 343;</td>
</tr>
<tr>
<td>Recurrence rate, REC (δ):</td>
<td>24.7243; 39.0606;</td>
</tr>
<tr>
<td>Determinism, DET (δ):</td>
<td>96.5712; 99.3247;</td>
</tr>
<tr>
<td>Shannon entropy</td>
<td>2.8420; 3.4933;</td>
</tr>
<tr>
<td>Detrended fluctuation analysis (DFA);</td>
<td></td>
</tr>
<tr>
<td>alpha 1</td>
<td>1.0498; 1.3855;</td>
</tr>
<tr>
<td>alpha 2</td>
<td>0.9310; 0.8909;</td>
</tr>
<tr>
<td>Others</td>
<td></td>
</tr>
<tr>
<td>Approximate entropy, ApEn</td>
<td>1.0498; 1.3855;</td>
</tr>
<tr>
<td>Sample entropy, SampEn</td>
<td>1.7331; 1.1493;</td>
</tr>
<tr>
<td>Correlation dimension, D2</td>
<td>4.0176; 3.2946;</td>
</tr>
</tbody>
</table>

Kubios HRV Analysis version 2.0 beta
BioSignal Analysis and Medical Imaging Group
Department of Physics
University of Kuopio, FINLAND
5.1. Sample run 1: General analysis

HRV Analysis – General Results

RR Interval Time Series

Selected Detrended RR Series

Time–Domain Results

Variable | Units | Value
---|---|---
Mean RR* | (s) | 1.220
STD RR (SDNN) | (s) | 0.046
Mean HR* | (1/min) | 49.33
STD HR | (1/min) | 2.40
RMSSD | (ms) | 58.9
NN50 | (count) | 179
pNN50 (%) | | 42.8
RR triangular index | | 0.085

Distributions*

Frequency–Domain Results

FFT spectrum (Welch’s periodogram: 128 s window with 50% overlap)

AR Spectrum (AR model order = 16, not factorized)

Nonlinear Results*

Poincare plot

Recurrence plot

Mean line length (Lmean) (beats) 8.04
Max line length (Lmax) (beats) 43
Recurrence rate (REC) (%) 24.72
Determinism (DET) (%) 96.57
Shannon Entropy (ShanEn) 2.842

Approximate entropy (ApEn) 1.041
Sample entropy (SampEn) 1.733
Detrended fluctuations (DFA)=1 1.070
Detrended fluctuations (DFA)=2 0.931
Correlation dimension (D2) 4.018

*Results are calculated from the non−detrended selected RR series.

Figure 5.2: Sample run 1, results for the lying period of the orthostatic test.
5.1. Sample run 1: General analysis

Figure 5.3: Sample run 1, results for the standing period of the orthostatic test.
5.2 Sample run 2: Time-varying analysis

In the second sample run, we show how to make time-varying analysis for the whole orthostatic HRV measurement. First of all, we need to enable the time-varying analysis from the preferences. To do this select Edit preferences from the File menu and check the time-varying analysis from Analysis options category of the preferences window. If you do not want to view any of the time-domain, frequency-domain, or nonlinear analysis results and nor do you wish to include any of them in the report sheets or results file, you should at the same time uncheck the general analysis from the preferences. Then press the OK button, and the time-varying analysis will be enabled in the user interface.

For the time-varying analysis we wish to include the whole measurement period and, thus, we set the Range of the RR interval sample to 0–737 seconds. This can be done using the Range edit boxes or by resizing the sample patch with the mouse. For the same reasons as in the first sample run we use again the smoothness priors detrending method with the Lambda value of 500.

The time-varying analysis results can then be viewed in the results view segment (press the Time-varying button). The variable in view can be selected from the two pop up buttons on the lower left hand corner of the results view. For example, in Fig. 5.4 (a) the time-domain variable pNN50 has been selected for view. All the time-domain variables as well as the two nonlinear variables are calculated using a moving window the width and time shift of which can be changed by editing the Window width and Grid interval values. Here we have used a 60 second window and a 10 second grid interval. The frequency-domain variables, on the other hand, are obtained from the time-varying spectrum estimate for which there are two different methods available. These are the spectrogram and the Kalman smoother methods. The spectrogram method is simply a moving window Fourier transformation method. The same moving window settings used for time-domain and nonlinear variables are also utilized for the spectrogram. The Kalman smoother method, on the other hand, is based on time-varying AR modeling and does not utilize the same kind of moving window as the spectrogram. Thus, the window width value does not apply to the frequency-domain variables if the Kalman smoother is used for spectrum estimation. The Grid interval is, however, utilized for the Kalman smoother method as well.

The differences between the spectrogram and Kalman smoother methods have been discussed in [42], where they were applied to nonstationary EEG signals. In brief, it can be said that the Kalman smoother is computationally more complex but yields better resolution than the spectrogram. The spectrogram is also more robust and requires only the moving window settings to be defined. The Kalman smoother methods, on the other hand, requires the fixing of both the adaptation coefficient and the AR mode order. Spectrogram and Kalman smoother spectrum estimates for the orthostatic measurement are presented in Figs. 5.4 (b) and (c). The adaptation coefficient of the Kalman smoother method was set to 0.1 and the AR model order to 16.

The results of the time-varying analysis can be saved as in the first sample run. If the general analysis was disabled from the preferences window, only time-varying results will be included in the PDF and ASCII text files. In the PDF-file the time-varying results are presented in one page shown in Fig. 5.5.
5.2. Sample run 2: Time-varying analysis

Figure 5.4: Sample run 2, time-varying results for the orthostatic test recording: (a) The time-varying trend of the pNN50 parameter, (b) the time-varying spectrum estimate using the spectrogram method, and (c) the time-varying spectrum estimate using the Kalman smoother method.
Figure 5.5: Sample run 2, time-varying results for the orthostatic test measurement.
Appendix A

Frequently asked questions

Based on the feedback and user experiences obtained from the users of the previous version of the HRV analysis software [32] we have collected here a bunch of frequently asked questions. An answer to each question is given below the question. Some of the questions are concerned with the optimal value of some analysis parameter. Often these parameter values are, however, more or less case-specific, for example the length of the selected HRV data may change the preferred settings for FFT spectrum calculation. Thus, some of the answers might be more or less vague, but hopefully still helpful.

- **What is the best way to treat artifacts in RR interval series?**
  When doing HRV analysis one should always make sure that the measured HRV series does not include any artifacts such as ectopic beats or missed/extra QRS detections. Thus, if ECG measurement is available, it is recommended that the ECG measurement, corresponding to the analyzed RR interval series, is checked for artifacts. In the software this can be easily done by scrolling the ECG signal. Any misdetections can be corrected straight and possible ectopic beats can be excluded from the analysis by suitable selections for the analyzed sample range.

- **When several RR interval samples have been selected, what does the merge samples do?**
  When the Merge samples option is selected for the Sample analysis type, the RR interval samples selected for analysis are simply merged into one sample by concatenating the samples.

- **How to select the value of \( \lambda \) in the smoothness priors based detrending?**
  \( \lambda \) is the regularization parameter in the smoothness priors based detrending approach, see Section 2.3.1 for details. The value of this parameter changes the smoothness of the estimated trend, i.e. a bigger value corresponds to a smoother trend. As discussed in Section 2.3.1 the smoothness priors detrending method can be compared to a time-varying highpass filter and \( \lambda \) adjusts the cut-off frequency of the filter. A practical way to observe what this cut-off frequency is for a specific \( \lambda \) value is as follows. Start, for example, from a big value (e.g. \( \lambda = 10000 \)) and decrease it to some desired value and observe from the FFT spectrum which frequencies were eliminated. Just remember to make sure that you are not eliminating frequencies of which you are interested in (e.g. watch out the lower limit of the LF band).
How to select the interpolation rate of the RR series?

The interpolation rate is related to the cubic spline interpolation that is used for converting the RR interval series to equidistantly sampled series. The default value for the interpolation rate is 4 Hz which works well for normal human HRV data. It should be noted that the interpolation rate should be at least twice as high as the highest expected frequency in the RR interval series. When changing the interpolation rate, it should be remembered that it affects on the smoothness priors based detrending method, i.e. when decreasing the interpolation rate also the λ value of the smoothness priors method should be decreased.

How to select the window width and overlap for the FFT spectrum estimate?

The FFT spectrum in the software is calculated using the Welch’s periodogram method where one or more overlapped segments are extracted from the data. Then FFT spectrum is calculated for each segment and as a result the average of the segment spectra is calculated. The selection of the window width and overlap in this method is simply a trade-off between the frequency resolution and variance of the spectrum estimate. The frequency resolution of FFT spectrum is roughly the reciprocal of the sample length (i.e. the frequency resolution of the FFT spectrum of a 100 second sample is ∼ 0.1 Hz). The variance of the FFT spectrum estimate, on the other hand, does not depend on the sample length, but can be decreased by averaging several shorter samples (which leads to decreased frequency resolution).

How to select the AR model order for the AR spectrum estimate?

The AR method is a parametric method which can be used also for spectrum estimation. In this method the RR interval series is modeled with an autoregressive model of specific order. The roots of the AR polynomial (which are actually complex conjugate pairs) correspond to the spectral peaks in the AR spectrum. Thus, the order of the AR model has to be at least twice the number of expected spectral peaks in the spectrum. In practice, the order is, however, always higher than this minimum and the few extra roots do not disturb the spectrum estimate. Even though, an exaggerated model order can induce spurious peaks into the AR spectrum estimate and distort the results. The AR model order naturally depends on the interpolation rate of the RR interval series, but in many cases the default order of 16 is reasonable.

Why do I get a warning “Negative component power in AR spectrum estimate”?

When factorization is used (see the Analysis options) for the AR spectrum estimate, the AR spectrum is divided into separate components (VLF, LF, and HF components). The power of each component is estimated using a method presented in [19]. This method works for well-separated AR roots, but for roots close to each other power estimates can yield even negative values which are obviously highly erroneous and a warning message is displayed. Because of this, and some other drawbacks, the AR spectrum factorization should be used judiciously. Instead, by disabling the factorization, more robust and in that sense more reliable results are obtained.
Why do the power values of Kubios HRV Analysis 2.0 spectrum estimates differ from those of the version 1.1?

The differences in power values are due to two changes. First of all, in version 2.0 the mean of the RR interval data is removed before spectrum estimation. This decreases significantly the VLF power value of the FFT based spectrum estimate. Secondly, the scaling of the spectrum estimates is changed as follows. In version 1.1 the spectrum estimates were scaled such that the total power from 0–$f_s$ Hz was equal to the variance of the RR data, where $f_s$ is the sampling frequency of the RR data (i.e. the interpolation rate). In version 2.0, on the other hand, the total power from 0–$f_s$/2 Hz is equal to the variance.

How to select the window width in time-varying analysis?

Here, the selection of the window width is a compromise between the “accuracy” of the calculated variable and its time resolution. For time-domain variables, the longer the window the more RR interval samples are used in the calculation of the variable value. In the frequency-domain, a longer window corresponds to better frequency resolution of the time-varying spectrum. On the other hand, using shorter window the time-variation of the changes in RR interval series characteristics is better observed.
Appendix B

Troubleshooting

- **Kubios HRV Analysis fails to start and gives the following error message:** “This application has failed to start because MCLMCRRT72.DLL was not found. Re-installing the application may fix this problem.”.

  This error message is produced if the Kubios HRV Analysis cannot find the MATLAB® Component Runtime (MCR). Verify that you have the MATLAB® Component Runtime (v7.2) installed on your system. The MATLAB® Component Runtime is included in the Kubios HRV Analysis installer. If you have the MCR installed and Kubios HRV Analysis still fails to start, make sure that the system path contains the entry for MCR (i.e., the `<MCR install dir>\v72\runtime\win32` directory is found in the system path). Note that in order to modify the system path you need to have administrator privileges.

- **The Kubios HRV Analysis seems to take ages to start.**

  The MATLAB® Compiler 4 has changed dramatically from the earlier versions. It is now more of a deployment tool than a compiler because it only generates a wrapper executable that starts the MATLAB® Component Runtime (MCR) and runs the heavily crypted Matlab M-files of the compiled application on top of the MCR. Although this has many advantages the main disadvantage is that the starting of the MATLAB® Component Runtime takes roughly the same time as starting MATLAB®. This can be anything from 10 to 50 seconds depending on the speed of the computer.

- **The report sheets print in black and white, although I’m printing to a color printer.**

  Due to a bug in the MATLAB® Compiler 4, printing directly to a printer does not work in a MATLAB® created standalone applications. Therefore, the printing system had to be developed in a different way for the Kubios HRV Analysis. Currently, the printing system uses GNU Ghostscript ([http://www.gnu.org/software/ghostscript/ghostscript.html](http://www.gnu.org/software/ghostscript/ghostscript.html)) to print exported postscript files. The generic Windows printing device included in the rather old version of GNU Ghostscript that is provided with the MATLAB® Component Runtime seems to have some problems printing in color. This will probably change when the printing bug is resolved (hopefully) in the future versions of MATLAB® Compiler. For now, the workaround is to export the report sheets to a PDF-file and print the resulting PDF-file using, e.g., Adobe Acrobat Reader.
References


63


